
 

Online Essentials Quiz 

 

Online Essentials – Ερωτήσεις Επιλογής & Πρακτικές Ασκήσεις 

Total Questions: 25 + 55 +45 

 

ΘΕΜΑ 1: Ερωτήσεις Πολλαπλών Επιλογών - Βασικές Έννοιες 

ΘΕΜΑ 2: Χρήση Προγράμματος Περιήγησης (Web Browser) - Google Chrome 

ΘΕΜΑ 3: Αναζήτηση Πληροφοριών (Search) 

ΘΕΜΑ 4: Ηλεκτρονικό Ταχυδρομείο (E-mail) - Microsoft Outlook 

               Δημιουργία και Αποστολή Email 

               Λήψη και Διαχείριση Email 

               Οργάνωση και Αναζήτηση Email 

ΘΕΜΑ 5: Επαφές (Contacts) 

ΘΕΜΑ 6: Ημερολόγιο (Calendar) 

 

Recommended Time: 125-155 minutes 

 

Αυτές οι πρακτικές ασκήσεις είναι ο πιο γρήγορος τρόπος για να μάθεις τη θεωρία σχετικά με βασικές 

έννοιες του διαδικτύου, για να εξοικειωθείς  με βασικές λειτουργίες του Google Chrome όπως επίσης 

και του Outlook. Εκτός από το ΘΕΜΑ 1, όλα τα άλλα θέματα προτείνεται να εκτελέσουν σε υπολογιστή. 

Αυτόνομα & Απλά®.  
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ΘΕΜΑ 1: Ερωτήσεις Πολλαπλών Επιλογών - Βασικές Έννοιες 

Θεωρητικές Γνώσεις Online Essentials 

 

Μέρος 1: Έννοιες Διαδικτύου (Internet Concepts) 

Τι σημαίνει το WWW; 

 Wide World Web 

 World Wide Web (Παγκόσμιος Ιστός) 

 Web World Wide 

 Worldwide Web Network 

Τι είναι το URL (Uniform Resource Locator); 

 Ένας τύπος ιού υπολογιστή (computer virus) 

 Ένα πρόγραμμα περιήγησης (web browser) 

 Η διεύθυνση μιας ιστοσελίδας (web address) 

 Μια μηχανή αναζήτησης (search engine) 

Τι είναι η υπερσύνδεση (hyperlink); 

 Ένα εργαλείο ασφαλείας (security tool) 

 Ένας σύνδεσμος που σας μεταφέρει σε άλλη σελίδα ή τοποθεσία 

 Ένα πρόγραμμα ηλεκτρονικού ταχυδρομείου (email program) 

 Μια μηχανή αναζήτησης (search engine) 

Ποια είναι η διαφορά μεταξύ Διαδικτύου (Internet) και Παγκόσμιου Ιστού (World Wide Web - WWW); 

 Είναι το ίδιο πράγμα 

 Το Διαδίκτυο είναι το δίκτυο, ο WWW είναι οι πληροφορίες πάνω σε αυτό 

 Ο WWW είναι παλαιότερος από το Διαδίκτυο 

 Το Διαδίκτυο είναι μόνο για emails 

Ποιο από τα παρακάτω είναι γεωγραφικός τομέας (geographic domain); 

 .com 

 .org 

 .uk 

 .edu 

Ποιο domain χρησιμοποιείται συνήθως για εκπαιδευτικά ιδρύματα (educational institutions); 

 .com (εμπορικό - commercial) 

 .org (οργανισμός - organization) 

 .edu (εκπαίδευση - education) 

 .gov (κυβέρνηση - government) 

Τι είναι ο φυλλομετρητής ιστού (web browser); 

 Ένα πρόγραμμα για αποστολή emails 

 Ένα πρόγραμμα για προβολή ιστοσελίδων  

http://www.hackyourbrain.eu/
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 Μια μηχανή αναζήτησης (search engine) 

 Ένα εργαλείο ασφαλείας (security tool) 

Ποιο από τα παρακάτω είναι παράδειγμα φυλλομετρητή ιστού (web browser); 

 Microsoft Word 

 Google Chrome 

 Adobe Photoshop 

 Windows Explorer 

 

Μέρος 2: Ασφάλεια στο Διαδίκτυο (Internet Security) 

Τι σημαίνει όταν μια διεύθυνση ιστοσελίδας ξεκινά με "https://"; 

 Η σελίδα είναι πολύ γρήγορη (very fast) 

 Η σελίδα είναι ασφαλής και κρυπτογραφημένη (secure and encrypted) 

 Η σελίδα έχει εικόνες (has images) 

 Η σελίδα είναι δημοφιλής (popular) 

Ποιο σύμβολο υποδεικνύει μια ασφαλή ιστοσελίδα (secure website); 

 Ένα αστέρι (star) 

 Ένα λουκέτο (κλειδαριά) 

 Μια ασπίδα (shield) 

 Ένα κλειδί (key) 

Τι είναι η κρυπτογράφηση (encryption); 

 Ένας τρόπος οργάνωσης αρχείων (organizing files) 

 Ένας τρόπος κωδικοποίησης δεδομένων για ασφάλεια (scrambling data for security) 

 Ένας τύπος ιστοσελίδας (type of website) 

 Μια μέθοδος αναζήτησης (search method) 

Τι είναι το τείχος προστασίας (firewall); 

 Ένα εργαλείο που προστατεύει τον υπολογιστή από μη εξουσιοδοτημένη πρόσβαση 

(unauthorized access) 

 Ένα πρόγραμμα περιήγησης (web browser) 

 Μια μηχανή αναζήτησης (search engine) 

 Ένα πρόγραμμα ηλεκτρονικού ταχυδρομείου (email program) 

Τι πρέπει να κάνετε μετά τη χρήση ασφαλούς ιστοσελίδας όπως ηλεκτρονική τραπεζική (online 

banking); 

 Να την αφήσετε ανοιχτή (leave it open) 

 Να κλείσετε μόνο την καρτέλα (close tab only) 

 Να αποσυνδεθείτε/αποσυνδεθείτε από την ιστοσελίδα (log out/disconnect) 

 Να διαγράψετε τον περιηγητή (delete browser) 

Τι είναι το ψηφιακό πιστοποιητικό (digital certificate); 

 Ένα πιστοποιητικό που επαληθεύει την ταυτότητα μιας ιστοσελίδας. Μπορεί να εκδοθεί από 

ένα τρίτο ανεξάρτητο φορέα αμοιβαίας εμπιστοσύνης.  

 Ένα πτυχίο υπολογιστών (computer degree) 

http://www.hackyourbrain.eu/
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 Ένας τύπος ιού (type of virus) 

 Ένα εργαλείο αναζήτησης (search tool) 

Τι είναι η ηλεκτρονική υφαρπαγή προσωπικών δεδομένων (phishing); 

 Ένα υδάτινο σπορ (water sport) 

 Μια απάτη για να σας εξαπατήσουν να δώσετε προσωπικές πληροφορίες (scam to trick you) 

 Ένας τύπος αναζήτησης (type of search) 

 Ένας τρόπος οργάνωσης emails 

 

Μέρος 3: Χρήση Φυλλομετρητή (Web Browser Usage) 

Τι είναι τα cookies (λανθάνον αρχεία); 

 Μικρά αρχεία κειμένου που αποθηκεύονται στον υπολογιστή σας από ιστοσελίδες (small files 

stored by websites) 

 Ιοί υπολογιστή (computer viruses) 

 Μηχανές αναζήτησης (search engines) 

 Συνημμένα αρχεία email (email attachments) 

Τι είναι ένα αναδυόμενο παράθυρο (pop-up); 

 Μια νέα ιστοσελίδα (new website) 

 Ένα παράθυρο που εμφανίζεται στην οθόνη τις περισσότερες φορές με διαφημιστικό υλικό 

 Ένας τύπος ιού (type of virus) 

 Ένα συνημμένο αρχείο email (email attachment) 

Τι είναι οι σελιδοδείκτες/αγαπημένα (bookmarks/favorites); 

 Αποθηκευμένοι σύνδεσμοι σε ιστοσελίδες (saved links to webpages) 

 Ένας τύπος αναζήτησης (type of search) 

 Ένα χαρακτηριστικό ασφαλείας (security feature) 

 Ένας φάκελος email (email folder) 

Τι σημαίνουν τα αρχικά ISP; 

 Internet Service Products  

 Internet Service Provider 

 Iam Super Powered 

 In Student Pad 

Πού πληκτρολογείτε τη διεύθυνση μιας ιστοσελίδας (URL); 

 Στο πλαίσιο αναζήτησης (search box) 

 Στη γραμμή διευθύνσεων (address bar) 

 Στους σελιδοδείκτες (bookmarks) 

 Στις ρυθμίσεις (settings) 

Ποιο από τα παρακάτω είναι ένας τρόπος να δημιουργήσετε σελιδοδείκτη (bookmark) στο Chrome; 

 Πατώντας το εικονίδιο του αστεριού (star icon) 

 Πατώντας Ctrl + D 

 Και τα δύο a και b 

http://www.hackyourbrain.eu/
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 Πατώντας Ctrl + S 

Ποιο από τα παρακάτω είναι ένας τρόπος να κάνετε εναλλαγή μεταξύ ανοικτών καρτελών Tabs στο 

Chrome; 

 Ctrl + Tab 

 Ctrl + Shift 

 Ctrl + Alt + Delete 

 Delete 

Τι είναι τα προσωρινά αρχεία Διαδικτύου (temporary Internet files/cached files); 

 Αρχεία που αποθηκεύονται προσωρινά για πιο γρήγορη φόρτωση σελίδων  

 Ιοί υπολογιστή (computer viruses) 

 Emails που διαγράφηκαν (deleted emails) 

 Αρχεία μουσικής (music files) και κωδικοί πρόσβασης 

 

Μέρος 4: Αναζήτηση Πληροφοριών (Information Search) 

Τι είναι μια μηχανή αναζήτησης (search engine); 

 Ένα εργαλείο για εύρεση πληροφοριών στο Διαδίκτυο (tool to find information on Internet) 

 Ένα πρόγραμμα email 

 Ένας φυλλομετρητής ιστού (web browser) 

 Ένας τύπος κινητήρα αυτοκινήτου (car engine type) 

Ποιο από τα παρακάτω είναι παράδειγμα μηχανής αναζήτησης (search engine); 

 Microsoft Word 

 Google 

 Google Chrome  

 Chrome Explorer 

  

http://www.hackyourbrain.eu/
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ΘΕΜΑ 2: Χρήση Προγράμματος Περιήγησης (Web Browser) - Google Chrome 

▪ Ανοίξτε το πρόγραμμα περιήγησης Google Chrome (Google Chrome browser). 

▪ Πληκτρολογήστε τη διεύθυνση (URL): www.wikipedia.org  στη γραμμή διευθύνσεων (address 

bar) και πατήστε Enter. 

▪ Ανοίξτε μια νέα καρτέλα (new taχρησιμοποιώντας το πληκτρολόγιο (Ctrl + T). 

▪ Στη νέα καρτέλα (new tab), πληκτρολογήστε τη διεύθυνση (URL): www.hackyourbrain.eu  

▪ Ανοίξτε σε ένα νέο παράθυρο (new window) την επιλογή  ‘hi'story (Δεξί κλικ > Open Link in 

New Window). 

▪ Πατήστε το κουμπί "Ανανέωση" (Refresh button) ή πατήστε F5 για να ξαναφορτώσετε τη 

σελίδα. 

▪ Κάντε κλικ σε μια υπερσύνδεση (hyperlink) που βρίσκεται στη σελίδα για να μεταβείτε σε 

άλλη σελίδα, για παράδειγμα στο EDUCATOR JOURNEY. 

▪ Κάντε δεξί κλικ (right-click) σε μια υπερσύνδεση (hyperlink) και επιλέξτε "Άνοιγμα σύνδεσης σε 

νέα καρτέλα" (Open link in new tab), για παράδειγμα στο Apla Word. 

▪ Μεταβείτε στη σελίδα: www.hackyourbrain.eu  και ορίστε την ως αρχική σελίδα 

(homepage/start page): 

3 κουκκίδες πάνω δεξιά (Menu) > Ρυθμίσεις (Settings) > Κατά την εκκίνηση (On startup) > 

Άνοιγμα συγκεκριμένης σελίδας (Open a specific page) 

 

▪ Εμφανίστε το ιστορικό περιήγησης (browsing history): 

3 κουκκίδες πάνω δεξιά (Menu) > Πατήστε Ιστορικό (History) > Επιλέξτε Ιστορικό (History) 

Πατήστε Ctrl + H ή Μενού > Ιστορικό (History) 

▪ Διαγράψτε το ιστορικό περιήγησης (browsing history): 

 3 κουκκίδες πάνω δεξιά (Menu) > Ιστορικό (History) > Διαγραφή δεδομένων 

περιήγησης (Clear browsing data) 

 Επιλέξτε "Ιστορικό περιήγησης" (Browsing history) και πατήστε "Διαγραφή 

δεδομένων" (Clear data) 

http://www.hackyourbrain.eu/
http://www.wikipedia.org/
http://www.hackyourbrain.eu/
http://www.hackyourbrain.eu/
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▪ Διαγράψτε τα προσωρινά αρχεία Διαδικτύου (temporary Internet files/cached images and 

files): 

 3 κουκκίδες πάνω δεξιά (Menu) > Ιστορικό (History) > Ιστορικό (History) 

 Επιλέξτε "Αρχεία και εικόνες στην κρυφή μνήμη" (Cached images and files) και 

πατήστε Delete browsing data 

 

▪ Εμφανίστε τα cookies που είναι αποθηκευμένα στον περιηγητή σας: 

 3 κουκκίδες πάνω δεξιά (Menu) > Ρυθμίσεις (Settings) > Απόρρητο και ασφάλεια 

(Privacy and security) > Cookies και άλλα δεδομένα ιστοτόπων (Cookies and other 

site data) 

▪ Διαγράψτε όλα τα cookies (cookies): 

 3 κουκκίδες πάνω δεξιά (Menu) > Ρυθμίσεις (Settings) > Απόρρητο και ασφάλεια 

Privacy and Security > Διαγραφή δεδομένων περιήγησης (Clear browsing data) 

 Επιλέξτε "Cookies και άλλα δεδομένα ιστοτόπων" (Cookies and other site data) και 

πατήστε "Διαγραφή δεδομένων" (Clear data) 

▪ Αποκλείστε Block τα αναδυόμενα παράθυρα Pop-ups: 

 3 κουκκίδες πάνω δεξιά (Menu) > Ρυθμίσεις (Settings) > Απόρρητο και ασφάλεια 

(Privacy and security) > Ρυθμίσεις ιστοτόπου (Site settings) > Αναδυόμενα 

παράθυρα και ανακατευθύνσεις (Pop-ups and redirects) > Δεν επιτρέπονται (Don't 

allow sites to send pop-ups) 

http://www.hackyourbrain.eu/
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▪ Μεταβείτε στη σελίδα www.bbc.com  και προσθέστε την στους σελιδοδείκτες/αγαπημένα 

(bookmarks/favorites): 

 Πατήστε το εικονίδιο του αστεριού Star icon στη γραμμή διευθύνσεων ή πατήστε 

Ctrl + D 

▪ Δημιουργήστε έναν νέο φάκελο σελιδοδεικτών (bookmarks folder) με το όνομα Εκπαίδευση 

(ή Education): 

 3 κουκκίδες πάνω δεξιά (Menu) > Σελιδοδείκτες (Bookmarks) > Διαχείριση 

σελιδοδεικτών Bookmark Manager 

 Κάντε δεξί κλικ (right-click) > Προσθήκη νέου φακέλου Add new folder 

▪ Προσθέστε τη σελίδα www.wikipedia.org  στο φάκελο "Εκπαίδευση": 

 Ανοίξτε τη σελίδα και πατήστε το αστέρι (star icon) 

 Επιλέξτε τον φάκελο "Εκπαίδευση" (Education folder) από το μενού 

▪ Διαγράψτε έναν σελιδοδείκτη (bookmark) από τη λίστα: 

 3 κουκκίδες πάνω δεξιά (Menu) > Σελιδοδείκτες (Bookmarks) > Διαχείριση 

σελιδοδεικτών (Bookmark Manager) 

 Βρείτε τον σελιδοδείκτη, κάντε δεξί κλικ και επιλέξτε "Διαγραφή" (Delete) 

▪ Ανοίξτε μια σελίδα που έχετε αποθηκεύσει στους σελιδοδείκτες (bookmarks): 

 3 κουκκίδες πάνω δεξιά (Menu) > Σελιδοδείκτες (Bookmarks) > Επιλέξτε τη σελίδα 

από τη λίστα 

▪ Αποθήκευσε στο Desktop (Save image as…) μια εικόνα από οποιανδήποτε ιστοσελίδα : 

 Κάντε δεξί κλικ (right-click) στην εικόνα 

 Επιλέξτε Save image as 

 Επιλέξτε φάκελο αποθήκευσης (Desktop) και πατήστε Save 

▪ Αντιγράψτε κείμενο από μια ιστοσελίδα σε ένα έγγραφο Word: 

 Επιλέξτε το κείμενο (select text) 

 Πατήστε Ctrl + C για αντιγραφή (copy) 

http://www.hackyourbrain.eu/
http://www.bbc.com/
http://www.wikipedia.org/
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 Ανοίξτε το Word και πατήστε Ctrl + V για επικόλληση (paste) 

▪ Αντιγράψτε τη διεύθυνση (URL) μιας ιστοσελίδας: 

 Κάντε κλικ στη γραμμή διευθύνσεων (address bar) 

 Πατήστε Ctrl + C για αντιγραφή (copy) 

 Ανοίξτε το Word και πατήστε Ctrl + V για επικόλληση (paste) 

▪ Εκτυπώστε (print) μια ιστοσελίδα: 

 Πατήστε Ctrl + P ή Μενού > Εκτύπωση (Print) 

 Επιλέξτε εκτυπωτή (printer) και επιλογές (options) 

 Πατήστε "Εκτύπωση" (Print) 

▪ Εκτυπώστε μόνο το επιλεγμένο κείμενο Selected text από μια ιστοσελίδα: 

 Επιλέξτε το κείμενο 

 Πατήστε Ctrl + P (ή τις 3 κουκκίδες στο πάνω δεξιό τμήμα του φυλλομετρητή και 

επιλέξτε Print) 

 Στις επιλογές, επιλέξτε "Επιλογή" (Selection) 

 Πατήστε  Print 

▪ Χρησιμοποιήστε το Google Translate για να μεταφράσετε μια ιστοσελίδα: 

 Μεταβείτε στο translate.google.com (ή αναζητήστε και ανοίξτε από τα αποτελέσματα 

αναζήτησης τη λειτουργία Google Translate. ) 

 Επιλέξτε από English σε Greek 

 Ανοίξτε μια νέα καρτέλα (new Tab) με Ctrl + T και μεταβείτε στην ιστοσελίδα 

www.hackyourbrain.eu . 

 Αντιγράψτε το κείμενο που βρίσκετε κάτω από τον τίτλο Our ‘H’istory και αρχίζει με 

Founded in 2012…. πατώντας Ctrl + C ή με δεξί κλικ και Copy 

 Επικολλήστε (paste) το κείμενο στο πρώτο πλαίσιο 

 Διαβάστε το κείμενο. 

 

ΘΕΜΑ 3: Αναζήτηση Πληροφοριών (Search) 

▪ Ανοίξτε τη μηχανή αναζήτησης (search engine) Google: www.google.com  

▪ Πληκτρολογήστε τις λέξεις-κλειδιά (keyworηλεκτρονικοί υπολογιστές και πατήστε Enter για 

αναζήτηση. 

▪ Πραγματοποιήστε αναζήτηση για να βρείτε εικόνες pictures σχετικά με φράση Τεχνητή 

Νοημοσύνη χρησιμοποιώντας τη λέξη pictures στο τέλος: 

 Πληκτρολογήστε: Τεχνητή Νοημοσύνη pictures 

▪ Πραγματοποιήστε νέα αναζήτηση εξαιρώντας (excluding) μια λέξη: 

 Πληκτρολογήστε: Τεχνητή Νοημοσύνη - chatgpt (θα βρει σελίδες με " Τεχνητή 

Νοημοσύνη " αλλά χωρίς το "chatgpt ") 

▪ Αναζητήστε πληροφορίες στην διαδικτυακή εγκυκλοπαίδεια Wikipedia English Version: 

 Μεταβείτε στο Google και πληκτρολογήστε τις λέξεις κλειδιά Wikipedia English 

Version 

 Ανοίξτε τη σχετική διεύθυνση από τα αποτελέσματα 

 Χρησιμοποιήστε το πλαίσιο αναζήτησης (search box) για να εμφανίσει πληροφορίες 

σχετικά με το Google Gemini 

http://www.hackyourbrain.eu/
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▪ Αξιολογήστε μια ιστοσελίδα για την αξιοπιστία της (reliability): 

 Ελέγξτε αν αναφέρεται ο συντάκτης (author) 

 Ελέγξτε αν το περιεχόμενο είναι επίκαιρο (current/up-to-date) 

 Ελέγξτε αν υπάρχουν αναφορές/πηγές (sources/references) 

 

 

▪ Αναγνωρίστε αν μια ιστοσελίδα είναι ασφαλής Secure: 

 Ελέγξτε αν η διεύθυνση (URL) ξεκινάει με "https://" 

 Ελέγξτε αν υπάρχει εικονίδιο κλειδαριάς δίπλα στη διεύθυνση 

 Ελέγξτε πότε λήγει το Digital Certificate 

 

ΘΕΜΑ 4: Ηλεκτρονικό Ταχυδρομείο (E-mail) - Microsoft Outlook 

Αν δεν έχετε ήδη ενεργό λογαριασμό στο Microsoft Outlook στον υπολογιστή σας, μπορείτε να 

χρησιμοποιήσετε τον υπάρχοντα λογαριασμό και να προχωρήστε στο κεφάλαιο Δημιουργία και 

Αποστολή Email αγνοώντας τα τη Ρύθμιση. Αν όχι, ακολουθήστε τα βήματα για να προσθέσετε το 

Gmail σας (π.χ. name.reinn@gmail.com) στο Outlook: 

Ρύθμιση - Προσθήκη Gmail στο Outlook (Προαπαιτούμενο για τις Ασκήσεις) 

▪ Ανοίξτε το Microsoft Outlook 

▪ 15. Πηγαίνετε στο: File) > Add Account 

▪ Πληκτρολογήστε τη διεύθυνση Gmail σας (π.χ. name.reinn@gmail.com) 

▪ Κάντε κλικ Connect 

▪ Πληκτρολογήστε τον κωδικό σας 

▪ Κάντε κλικ Connect ή Next 

▪ Περιμένετε να ολοκληρωθεί ο συγχρονισμός (synchronization). Το Outlook θα κατεβάσει και 

εμφανίσει τα emails σας. 

▪ Κάντε κλικ Done) ή Finish 

 

Δημιουργία και Αποστολή Email 

▪ Ανοίξτε το Microsoft Outlook. 

▪ Δημιουργήστε ένα νέο μήνυμα ηλεκτρονικού ταχυδρομείου: 

 Πατήστε New Email  

▪ Στο πεδίο "Προς" To, πληκτρολογήστε τη διεύθυνση: reinninstitute@gmail.com  

▪ Στο πεδίο "Θέμα" Subject, πληκτρολογήστε: Εργασία Πληροφορικής 

▪ Στο κυρίως σώμα του μηνύματος message body, γράψτε: Αγαπητό μου Reinn Comp, σου 

στέλνω την εργασία μου. 

▪ Προσθέστε ένα συνημμένο αρχείο (attachment): 

 Πατήστε "Επισύναψη αρχείου" (Attach File - συνδετηράκι) 

 Επιλέξτε ένα αρχείο από τον υπολογιστή σας (οτιδήποτε) 
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 Πατήστε Insert 

▪ Διαγράψτε το συνημμένο αρχείο (attachment) από το email: 

 Κάντε κλικ στο "X" δίπλα στο όνομα του αρχείου 

▪ Προσθέστε έναν παραλήπτη στο πεδίο "Κοινοποίηση" (Cc): 

 Κάντε κλικ στο πεδίο "Cc" 

 Πληκτρολογήστε: eleni.yi@gmail.com  

▪ Προσθέστε έναν παραλήπτη στο πεδίο "Κρυφή Κοινοποίηση" (Bcc): 

 Κάντε κλικ στο πεδίο “To” ή "Cc" για να ανοίξει το σχετικό παράθυρο στο οποίο θα 

δείτε κάτω-κάτω το πεδίο Bcc 

 Κάντε κλικ στο πεδίο Bcc 

 Πληκτρολογήστε: eleni.yi@gmail.com  

▪ Ελέγξτε την ορθογραφία (spelling) του μηνύματος: 

 Πατήστε F7 ή από την κορδέλα, επιλέξτε Review > Spelling & Grammar 

▪ Αποστείλετε το μήνυμα (send email): 

 Πατήστε Send 

▪ Αποστείλετε ένα μήνυμα με υψηλή προτεραιότητα (high priority): 

 Κατά τη σύνθεση του email, πατήστε "Υψηλή Σημασία" (High Importance - κόκκινο 

θαυμαστικό) 

▪ Δημιουργήστε ένα email αλλά μην το στείλετε - αποθηκεύστε το ως πρόχειρο (draft): 

 Κλείστε το παράθυρο του email 

 Θα αποθηκευτεί αυτόματα στο φάκελο "Πρόχειρα" Drafts 

 

Λήψη και Διαχείριση Email 

▪ Ανοίξτε ένα μήνυμα από τα "Εισερχόμενα" Inbox: 

 Κάντε διπλό κλικ (double-click) στο μήνυμα 

▪ Απαντήστε στον αποστολέα (reply to sender): 

 Ανοίξτε το μήνυμα 

 Πατήστε Reply 

 Γράψτε την απάντησή σας και πατήστε Send 

▪ Απαντήστε σε όλους τους παραλήπτες (reply to all): 

 Ανοίξτε το μήνυμα 

 Πατήστε Reply All 

 Γράψτε την απάντησή σας και πατήστε Send 

▪ Προωθήστε (forwarένα μήνυμα σε άλλο παραλήπτη: 

 Ανοίξτε το μήνυμα 

 Πατήστε Forward 

 Προσθέστε τη διεύθυνση του νέου παραλήπτη 

 Πατήστε Send 

▪ Σκεφτείτε – Αν ένα email εκτός από κείμενο έχει μέσα και ένα έγγραφο ή μια φωτογραφία, 

εσείς, μπορείτε να το αποθηκεύσετε στον υπολογιστή σας. Για να αποθηκεύστε ένα 

συνημμένο αρχείο (attachment) από ένα email που λάβατε θα πρέπει να: 
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 Ανοίξτε το μήνυμα 

 Κάντε δεξί κλικ right-click στο συνημμένο αρχείο 

 Επιλέξτε Save As 

 Επιλέξτε φάκελο αποθήκευσης (π.χ Desktop) και πατήστε "Αποθήκευση" (Save) 

▪ Σκεφτείτε – Αν ένα email εκτός από κείμενο έχει μέσα και ένα έγγραφο ή μια φωτογραφία, 

εσείς, μπορείτε να το ανοίξετε. Για να ανοίξτε ένα συνημμένο αρχείο (attachment): 

 Κάντε διπλό κλικ στο συνημμένο αρχείο 

▪ Σκεφτείτε – Αν θέλετε να εκτυπώσετε Εκτυπώστε (print) ένα μήνυμα email: 

 Ανοίξτε το μήνυμα 

 Πατήστε Ctrl + P ή File > Print 

▪ Επισημάνετε ένα μήνυμα ως αναγνωσμένο (mark as read): 

 Κάντε δεξί κλικ στο μήνυμα 

 Επιλέξτε "Επισήμανση ως αναγνωσμένο" Mark as Read 

▪ Επισημάνετε ένα μήνυμα ως μη αναγνωσμένο (mark as unread): 

 Κάντε δεξί κλικ στο μήνυμα 

 Επιλέξτε "Επισήμανση ως μη αναγνωσμένο" Mark as Unread 

▪ Σημαδέψτε (flag) ένα μήνυμα για παρακολούθηση: 

 Κάντε δεξί κλικ στο μήνυμα 

 Επιλέξτε "Παρακολούθηση" (Follow Up) > "Σημαία" (Flag) 

 

Οργάνωση και Αναζήτηση Email 

▪ Δημιουργήστε έναν νέο φάκελο (New Folder) με το όνομα Computer Class: 

 Κάντε δεξί κλικ στα "Εισερχόμενα" Inbox ή στο όνομα του λογαριασμού 

 Επιλέξτε "Νέος φάκελος" New Folder 

 Πληκτρολογήστε Computer Class και πατήστε Enter 

▪ Δημιουργήστε έναν νέο φάκελο (New Folder) με το όνομα School: 

 Κάντε δεξί κλικ στα "Εισερχόμενα" Inbox ή στο όνομα του λογαριασμού 

 Επιλέξτε "Νέος φάκελος" New Folder 

 Πληκτρολογήστε School και πατήστε Enter 

▪ Μετακινήστε ένα μήνυμα (οποιονδήποτε) στο φάκελο Computer Class: 

 Σύρετε (drag) το μήνυμα στο φάκελο Computer Class 

 Ή κάντε δεξί κλικ > Move > Computer Class 

▪ Διαγράψτε το φάκελο School: 

 Κάντε δεξί κλικ στο φάκελο School 

 Επιλέξτε Delete Folder 

▪ Αναζητήστε (search) ένα μήνυμα βάσει αποστολέα (sender): 

 Πατήστε στο πλαίσιο αναζήτησης (search box) πάνω από τα μηνύματα 

 Πληκτρολογήστε το όνομα ή το email του αποστολέα (σίγουρα θα έχεις κάποιο 

ενημερωτικό email από το Google, άρα μπορείς να γράψεις Google) 

▪ Αναζητήστε ένα μήνυμα βάσει θέματος (subject): 

 Πατήστε στο πλαίσιο αναζήτησης (search box) 
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 Πληκτρολογήστε: θέμα: Security (σίγουρα θα έχεις κάποιο ενημερωτικό email σχετικό 

με θέματα ασφαλείας από το Google) 

 Ή απλά πληκτρολογήστε λέξεις-κλειδιά από το θέμα 

▪ Ταξινομήστε Sort τα μηνύματα βάσει ημερομηνίας (date): 

 Κάντε κλικ στην επικεφαλίδα "Ημερομηνία" Date στο φάκελο εισερχομένων 

▪ Ταξινομήστε Sort τα μηνύματα βάσει αποστολέα (sender): 

 Κάντε κλικ στην επικεφαλίδα "Από" From 

▪ Ταξινομήστε Sort τα μηνύματα βάσει μεγέθους Size: 

 Κάντε δεξί κλικ στις επικεφαλίδες των στηλών 

 Επιλέξτε "Μέγεθος" Size για να εμφανιστεί η στήλη 

 Κάντε κλικ στην επικεφαλίδα "Μέγεθος" Size 

▪ Διαγράψτε ένα μήνυμα: 

 Επιλέξτε το μήνυμα 

 Πατήστε "Delete" ή κάντε κλικ στο εικονίδιο "Διαγραφή" Delete 

▪ Επαναφέρετε ένα μήνυμα από τον φάκελο "Διαγραμμένα" (Deleted Items): 

 Ανοίξτε το φάκελο "Διαγραμμένα" 

 Σύρετε το μήνυμα πίσω στα "Εισερχόμενα" (Inbox) 

▪ Αδειάστε (empty) το φάκελο "Διαγραμμένα" (Deleted Items): 

 Κάντε δεξί κλικ στο φάκελο "Διαγραμμένα" 

 Επιλέξτε "Άδειασμα φακέλου" Empty Folder 

▪ Σκεφτείτε – Αν επιθυμείτε να μετακινήστε ένα μήνυμα στο φάκελο "Ανεπιθύμητη 

Αλληλογραφία" Junk/Spam θα μπορούσατε να το κάνετε ως ακολούθως: 

 Κάντε δεξί κλικ στο μήνυμα 

 Επιλέξτε "Ανεπιθύμητα" (Junk) > "Αποκλεισμός αποστολέα" Block Sender 

ΘΕΜΑ 5: Επαφές (Contacts) 

▪ Ανοίξτε τις Επαφές Contacts στο Outlook: 

 Κάντε κλικ στο εικονίδιο "Άτομα" People ή "Επαφές" Contacts στο κάτω μέρος της 

οθόνης 

▪ Δημιουργήστε μια νέα επαφή (new contact) με τα εξής στοιχεία: 

 Πατήστε "Νέα επαφή" New Contact 

 Όνομα (Name): Eleni Yiangou 

 Email: eleni.yi@gmail.com  

 Τηλέφωνο (Phone): 99773185 

 Πατήστε "Αποθήκευση και κλείσιμο" New Contact  

▪ Δημιουργήστε μια νέα επαφή (new contact) με τα εξής στοιχεία: 

 Πατήστε "Νέα επαφή" New Contact 

 Όνομα (Name): Takis Taki 

 Email: takis@test.com  

 Πατήστε "Αποθήκευση και κλείσιμο" Save & Close 

▪ Δημιουργήστε μια νέα επαφή (new contact) με τα εξής στοιχεία: 

 Πατήστε "Νέα επαφή" New Contact 

 Όνομα (Name): Reinn Comp 
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 Email: reinninstitute@gmail.com 

 Web Page Address: www.hackyourbrain.eu  

 Πατήστε "Αποθήκευση και κλείσιμο" (Save & Close) 

▪ Προσθέστε μια επαφή απευθείας από ένα email που λάβατε: 

 Ανοίξτε το email 

 Κάντε δεξί κλικ στη διεύθυνση του αποστολέα 

 Επιλέξτε "Προσθήκη στις επαφές του Outlook" (Add to Outlook Contacts) 

▪ Ενημερώστε (update) τα στοιχεία μιας υπάρχουσας επαφής: 

 Ανοίξτε τις Επαφές 

 Κάντε διπλό κλικ στην επαφή Eleni Yiangou 

 Γράψτε στο πεδίο Web Page Address www.hackyourbrain.eu  

 Πατήστε "Αποθήκευση και κλείσιμο" (Save & Close) 

▪ Δημιουργήστε μια νέα ομάδα επαφών (contact group) με το όνομα Computer Class Group: 

 Στις Επαφές, πατήστε "Νέα ομάδα επαφών" (New Contact Group) 

 Πληκτρολογήστε το όνομα: Computer Class Group 

 Πατήστε "Αποθήκευση και κλείσιμο" Save & Close χωρίς να προσθέσετε κάποιο 

μέλος. 

▪ Προσθέστε την επαφή Eleni Yiangou στην Computer Class Group: 

 Ανοίξτε την Computer Class Group 

 Πατήστε "Προσθήκη μελών" (Add Members) 

 Επιλέξτε Reinn Comp και Πατήστε "Μέλη" Members 

 Επιλέξτε Eleni Yiangou Πατήστε "Μέλη" Members 

 Επιλέξτε Takis Taki Πατήστε "Μέλη" Members 

 Πατήστε ΟΚ 

 Πατήστε "Αποθήκευση και κλείσιμο" Save & Close 

▪ Αφαιρέστε ένα μέλος από μια ομάδα επαφών: 

 Ανοίξτε την ομάδα επαφών Computer Class Group 

 Επιλέξτε το μέλος που θέλετε να αφαιρέσετε, τον Takis Taki 

 Πατήστε "Κατάργηση μέλους" Remove Member 

 Πατήστε "Αποθήκευση και κλείσιμο" Save & Close 

▪ Διαγράψτε μια επαφή (delete contact): 

 Επιλέξτε την επαφή Takis Taki 

 Πατήστε "Delete" ή κάντε δεξί κλικ > "Διαγραφή" (Delete) 

▪ Στείλτε ένα email σε μια ολόκληρη ομάδα επαφών: 

 Δημιουργήστε νέο email New Mail 

 Στο πεδίο "Προς", πληκτρολογήστε το όνομα της ομάδας Computer Class Group 

 Γράψτε το μήνυμα και στείλτε το Send 

▪ Διαγράψτε μια ομάδα επαφών (contact group): 

 Επιλέξτε την ομάδα 

 Πατήστε "Delete" 

ΘΕΜΑ 6: Ημερολόγιο (Calendar) 

▪ Ανοίξτε το Ημερολόγιο Calendar στο Outlook: 
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 Κάντε κλικ στο εικονίδιο "Ημερολόγιο" (Calendar) στο κάτω μέρος της οθόνης 

▪ Δημιουργήστε μια νέα συνάντηση (meeting/appointment): 

 Πατήστε "Νέα συνάντηση" (New Meeting) ή "Νέο ραντεβού" (New Appointment) 

 Θέμα (Subject): Computers Exam 

 Ημερομηνία (Date): 20/12/2025 

 Ώρα έναρξης (Start time): 13:00 

 Ώρα λήξης (End time): 14:00 

 Πατήστε Save & Close 

▪ Προσκαλέστε άτομα σε μια συνάντηση (invite attendees to a meeting): 

 Δημιουργήστε νέα συνάντηση 

 Πατήστε Invite Attendees 

 Προσθέστε τις επαφές Eleni Yiangou και Reinn Comp στο πεδίο "Προς" (πατήστε 

πάνω στο κουμπί To για να ανοίξουν οι επαφές.  

 Συμπληρώστε τα υπόλοιπα στοιχεία 

 Πατήστε "Αποστολή" (Send) 

▪ Σκεφτείτε – Όταν θα έχετε λάβει μια νέα πρόσκληση συνάντησης και θέλετε να την 

Αποδεχτείτε (accept): 

 Ανοίξετε το email πρόσκλησης 

 Πατήστε "Αποδοχή" Accept 

 Επιλέξτε "Αποστολή απάντησης τώρα" (Send the response now) 

▪ Σκεφτείτε – Όταν θα έχετε λάβει μια νέα πρόσκληση συνάντησης και θέλετε να την 

Απορρίψτε (decline): 

 Ανοίξετε το email πρόσκλησης 

 Πατήστε "Απόρριψη" Decline 

 Επιλέξτε "Αποστολή απάντησης τώρα" 

▪ Σκεφτείτε – Όταν θα έχετε λάβει μια νέα πρόσκληση συνάντησης και θέλετε απαντήστε 

"Προσωρινά / Ίσως για λίγο" (Tentative) θα πρέπει να: 

 Ανοίξετε το email πρόσκλησης 

 Πατήστε "Προσωρινά" Tentative 

 Επιλέξτε "Αποστολή απάντησης τώρα" 

▪ Εφαρμόστε διαφορετικές προβολές Views στο ημερολόγιό σας: 

 Ημέρα (Day view) 

 Εβδομάδα (Week view) 

 Μήνας (Month view) 
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